VYSOKE UCENI TECHNICKE V BRNE

J BRNO UNIVERSITY OF TECHNOLOGY

%

FAKULTA ELEKTROTECHNIKY A KOMUNIKACNICH
TECHNOLOGII

»
J USTAV RADIOELEKTRONIKY

S
//

@ FACULTY OF ELECTRICAL ENGINEERING AND COMMUNICATION
DEPARTMENT OF RADIO ELECTRONICS

]

LABORATORNI PRIPRAVEK PRO VYVOJ APLIKACI
OBVODU CPLD FIRMY ALTERA

LABORATORY KIT FOR DEVELOPMENT APPLICATION OF ALTERA CPLD DEVICES

DIPLOMOVA PRACE
MASTER’'S PROJECT

AUTOR PRACE Bc. Petr Gajdosik

AUTHOR

VEDOUCI PRACE doc. Ing. Jaromir Kolouch, CSc.
SUPERVISOR

BRNO, 2012



||| ]] | VYSOKE UCENI
| | TECHNICKE V BRNE

L : Fakulta elektrotechniky
| a komunikaénich technologii

LT

N Ustav radioelektroniky

Diplomova prace

magistersky navazujici studijni obor
Elektronika a sdélovaci technika

Student: Bc. Petr Gajdosik iD: 109650
Roénik: 2 Akademicky rok: 2011/2012
NAZEV TEMATU:

Laboratorni pripravek pro vyvoj aplikaci obvodu CPLD firmy Altera

POKYNY PRO VYPRACOVANI:

Prostudujte viastnosti a zplsoby programovani obvodu fady MAX-II firmy Altera. Vypracujte navrh
laboratorniho pfipravku pro praci s témito obvody a pro jejich demonstraci v laboratornich cvicenich,
splnujici tyto poZadavky:

a) vstup udajl z pfepinacil na desce, b) indikaci stavu vystupu signalkami LED a multiplexnim
displejem, c) moZnost pfipojeni dalSich periferii pomoci konektoru.

Ptipravek realizujte a ovéfte jeho funkci véetné ovéfeni pouzitelnosti vSech dostupnych programovacich
prostiedku (kabely Altera, Presto).

Zpracujte vzorové pfiklady k demonstraci funkce pfipravku véetné simulace funkéni a post-fit, a navod
pro praci s pfipravkem. Soucasti pfikladu ma byt 3ablona pro vkladani testovanych konstrukci do
pfipravku s textovou i schematickou vrcholovou jednotkou. Prozkoumejte také moZnosti stanoveni
casovych parametri konstrukei statickou ¢asovou analyzou.

DOPORUCENA LITERATURA:

[1] MAX Il Device Handbook. Dostupné na www:
http:/imww.altera.com/literature/hb/max2/max2_miiSv1.pdf)

[2] KOLOUCH, J. Programovatelné logické obvody a navrh jejich aplikaci v jazyku VHDL. Skriptum.
Brno: FEKT VUT v Brné, 2006. ISBN 80-214-3271-3.

Termin zadani: 6.2.2012 Termin odevzdani: 1852012
Vedouci prace: doc. Ing. Jaromir Kolouch, CSc.

Konzultanti diplomové prace:

prof. Dr. Ing. Zbynék Raida
Predseda oborové rady


http://altera.com/iiterature/hb/max2/rn

ABSTRAKT

V diplomové praci se zaméfuji na navrh schematu laboratorniho piipravku a

prostudovani zpusobtl programovani obvodi CPLD firmy Altera. Pripravek slouZzi pro
vyvoj a demonstraci aplikaci v obvodech CPLD firmy Altera. Ptipravek je navrzen pro
programovani kabely Altera a Presto (vyrobce ASIX). Vstupni signaly jsou realizovany
soustavou prepinacu a tlacitek na desce. Stavy vystupl jsou zobrazovany na LED
diodach, pfipadné na pfipojeném multiplexnim displeji. Uzivatel ma moznost pfipojit
externi zafizeni, pfes externi vstupy.
Prace je dale zaméfena na navrh desky plosnych spoji laboratorniho pripravku,
nasledné vyrobé, oziveni pripravku a ovéreni kompatibility programatord ALTERA a
PRESTO. Zavér prace je zaméfen na praci s navrhovym prostfedim QUARTUS IL
Zejména se jedna o navod na praci se Sablonami a simulaci VHDL konstrukci.

KLICOVA SLOVA
Laboratorni pfipravek, CPLD, Altera, JTAG, VHDL, QUARTUS II.

ABSTRACT

In this thesis I aim at a design of the laboratory kit and study ways how to
programme CPLD devices made by Altera company. The product is used for
development and demonstration of applications in CPLD devices made by Altera
company. The kit is designed for Altera programming cables and Presto (made by
ASIX). Input signals are implemented by a set of switches and buttons on the board.
Output states are displayed by LED diods, possibly connected to multiplex the display.
The user can connect to external devices via external inputs.

Thesis is also aimed at the design PCB of the laboratory kit, subsequent production,
recovery and verification of compatibility ALTERA and PRESTO programmers. End of
the thesis aims on working with the Quartus II design environment. In particular, it is a
guide to working with templates and simulation of VHDL designs.

KEYWORDS
Laboratory kit, CPLD, Altera, JTAG, VHDL, QUARTUS II.
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UvoD

Ukolem diplomové prace je prostudovat moznosti programovani obvodd CPLD
firmy Altera a navrhnout schema laboratorniho pfipravku s obvodem firmy Altera.
Obvody CPLD neboli Complex Programmable Logic Devices, jsou slozité¢ logické
obvody, které se vyuzivaji hlavné pro jejich rychlost a flexibilitu. Mizeme je nalézt
v ruznych aplikacich, kde neni mozné vyuzit mikroprocesoru a kde se klade daraz na
rychlost jednoduchych operaci jako je multiplexovani, jednoduché aritmetické operace
a dalsi operace v kterych mikrokontrolery za témito obvody zaostavaji.

Laboratorni ptipravek se tedy bude skladat z obvodu CPLD firmy Altera, ktery
bude programovan pies rozhrani JTAG. Hlavni zaméfeni bude na moznost
programovani pres externi programator Presto firmy Asix, ktery je momentalné velmi
roz§itenym prostiedkem. Pfipravek bude napéjen zdrojem o napéti 5 V. Jako vstupni
periferie zde budou pouzity sestava prepinacu a také nékolik tlacitek, které budou na
desce oSetfeny proti zakmitim pii stisku. Toto oSetfeni bude mozné i odpojit, kvili
moznosti vytvoreni programového oSetieni téchto zakmiti. LED diody a 7segmentovy
multiplexni displej budou pouzity pro zobrazeni vystupt. Nebude zde chybét ani
moznost pripojeni externich modull pres vyvedené konektory na desce.

Dalsim tkolem je navrhnout desku plosnych spoju s naslednym osazenim
soucastkami a ozivenim. Celé prace bude vrcholit n€kolika priklady VHDL konstrukci
pro ovéfeni funk¢nosti desky a manualem pro praci s pfipravkem a s vytvofenou
Sablonou v navrhovém prostiedi QUARTUS IL



1 PROGRAMOVATELNE LOGICKE
OBVODY

V této kapitole jsou pouzity informace z pramenu [2]. Cislicové programovatelné
obvody se vSeobecné¢ oznaCuji zkratkou PLD. Je to zkratka slovniho spojeni
Programmable Logic Devices. Jsou to obvody, které jsou slozeny z mnoha logickych
obvodi. Nejmensim stavebnim prvkem je dvouvstupé hradlo NAND. Tyto obvody
samoziejmé neobsahuji jen je. Programovatelné jsou proto, ze uzivatel je schopny si
tyto obvody nakonfigurovat podle svych potreb.

Programovatelné logické obvody se déli na tfi zakladni typy. Jsou to SPLD (Simple
Programmable Logic Devices), CPLD (Complex Programmable Logic Devices) a
obvody FPGA (Field Programmable Gate Arrays).

Velikost PLD obvodi se uvadi vétSinou ve dvou jednotkach. Je to pocet hradel,
avSak jde o zavadéjici pojem, protoze fada hradel je pouzita na pomocné a systémoveé
funkce. Z toho divodu je vhodné&jsi jednotkou velikosti PLD obvodu uZzivany pocet
makrobunék. Makroburika je vzdy jeden pamétovy Clen (klopny obvod typu D), ktery je
doplnény o fadu pomocnych hradel. Podoba makroburiky se u kazdého typu PLD
obvodu lisi. Typicka struktura makroburiky z nejjednodussich obvodu PAL je zobrazena
na Obrazku 1.1.
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bloky sdruzujici i fadu dalSich funkci.

Vyhody téchto obvoda jsou v tom, Ze jsou velmi rychlé. Jsou schopné pracovat na
frekvencich stovek MHz. Zvlasté kvili jejich rychlosti jsou vhodné na mistech, kde je
potieba rychla reakce, naptiklad sitové prepinace (switch), zpracovani rychlych signalt.



Dalsi vyhodou je tzv. pinova rovnocennost. Az na par specialnich pini muzeme
kterykoliv pin ustanovit na nami zvolenou funkci. To usnadniuje navrh desky plosSného
spoje.

Nevyhodou je Casta nutnost napajeni téchto obvodu vice standardy napajeciho
napéti. Ale tato vlastnost neni pravidlem, jelikoz uz mnoho obvodi ma v sobé
implementovana tzv. multivoltage cores, coz vede k moznosti napéjeni jadra a periferii
stejnou velikosti napéti. Dal§i nevyhodou téchto obvoda je jejich Casta absence
analogovych obvodu (naptiklad DAC), ale to posledni dobou neni problém, jelikoz
dosti Casto se vyuziva kombinace PLD obvodu s mikroprocesory.

1.1  SPLD

V této kapitole jsou pouzity informace zpramenu [2]. Jsou to jednoduché
programovatelné obvody PAL, GAL, PLA a podobné. Jedna se o zastaralé obvody,
které v sobé seskupovaly jen malé mnozstvi makrobunék, coz umoziovalo
naprogramovat jen jednoduché logické funkce. Obvody maji pfedem definované
vstupni a vystupni piny a uzivatel jen konfiguruje vlastni logickou funkci pro kazdy
vystup zvlast, jelikoz na kazdém vystupu je umisténa jedna makroburika. Zakladni
princip obvodu fady PAL je na Obrazku 1.2.
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Obrazek 1.2 Zakladni princip obvodu PAL (pfevzato z [2])

Jde o zobrazeni zakladniho principu obvodi PAL. Vlevo nahote jsou vstupy
obvodu. Jejich invertovana a neinvertovana hodnota je pfivedena na sou¢inovou matici
AND. Kazdy vodorovny spoj protinajici tuto matici reprezentuji vzdy jedno soucinoveé
hradlo. Tento spoj v sobé€ sdruzuje vice vstupt hradla ke kterému vedou a tim je mozné
na kazdé takové hradlo pfipojit vice vstupnich signali. Vystupy téchto hradel se spojuji
v souctovém hradle OR a ptes ptipadnou dalsi logiku prochazeji az na vystupni pin.
Zaroven se tyto signaly Casto vraceji 1 zp€t do matice, takze je mozné jejich stav vyuzit i
u ostatnich ¢asti obvodu.

Na kazdém vystupnim pinu je navic umisténa jedna (jednobitova) makroburika.

Jejich nejvétsi zastupce je obvod PAL22V10, ktery obsahuje 10 vystupt a tedy 10
makrobunék. Coz mimo jiné znamena, ze z takového obvodu bylo mozné vytvofit
maximalné desetibitovy binarni ¢itac, ktery jiz v§ak nemohl vykonavat nic dalsiho.



1.2 CPLD

V této kapitole jsou pouzity informace zpramenu [2]. Obvody SPLD jsou
v podstaté zakladem pro obvody CPLD (neboli slozité programovatelné logické
obvody). Jejich typicka struktura je zobrazena na Obrazku 1.3.
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Obrazek 1.3 Struktura obvodi CPLD (pfevzato z [2])

Jak lze vidét ze struktury obvodu CPLD, jde o matici mnoha obvodia SPLD, které
konstrukci. Momentalné lze od spolecnosti Altera ziskat obvody o velikosti od 192 —
1700 makroburi€k, coz znamena vétsi volnost, nezli u obvoda SPLD. Vétsina obvoda
CPLD obsahuje 1 interni pamét EEPROM pro trvalé ulozeni konfigurace obvodu,coz je
vyhodou ve chvili, preruSeni napéajeni obvodu, jednak nemusi byt obvod nové
naprogramovan a nemusi se vyuzivat externi pameti Flash pro obnovu konfigurace.

1.3 FPGA

V této kapitole jsou pouzity informace zpramenu [2]. Obvody FPGA jsou

vvvvvv

makrobunék jsou slozeny z tzv. logickych blokti a obsahuji az miliony ekvivalentnich
hradel (typické dvouvstupé hradlo NAND).

Na Obrazku 1.4 je typicka struktura FPGA.
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Obrazek 1.4 Struktura FPGA (prevzato z [2])

Tyto obvody ve velké mife obsahuji pro svou konfiguraci pouze integrovanou
pamét RAM. Z toho divodu je obvod nutné po kazdém zapnuti znovu nakonfigurovat.
To lze zatidit externi paméti eeprom, z které si dokazou obvody FPGA po zapnuti samy
nacist svou konfiguraci.



2  POUZITI OBVODU ALTERA MAX II

V této kapitole jsou pouzity informace z pramenu [3]. Pro navrh laboratorniho
ptipravku byl zvolen obvod CPLD tfady MAX II od spole¢nosti ALTERA. Jedna se o
EPM240T100I5N. Je to nejmensi velikost obvodu této fady a obsahuje 192
makrobunék, coz staci pro zakladni aplikace v rozsahu zadanych funkci laboratorniho
ptipravku.

2.1  Vlastnosti rodiny MAX II

e nizka cena, nizka spotieba CPLD

obsahuje nevolatilni architekturu (neni nutno po kazdém spusténi

konfigurovat)

odbér v pohotovostnim rezimu mens$i nez 25 uA

Moznost vyuziti 4 globalnich hodinovych vstupti

UFM (User Flash Memory) blok o velikosti az 8 Kbits nevolatilni paméti

Jadro s podporou vice napétovych standardi 3.3 V/2.5 Vnebo 1.8 V

Vstupné vystupni rozhrani podporujici napetové standarty 3.3 V, 2.5V,

18V,15V

e  Architektura obvodu umoziuje programovatelnou rychlost prebéhu, a
programovatelné pull-up a pull-down rezistory

e  Moznost nastaveni na kazdy pin prichod Schmittovym obvodem pro
odruseni Sumu

e  Vstupy a vystupy obvodu jsou pln¢ kompatibilni s PCI SIG (Peripheral
Component Interconnect Special Interest Group) PCI Local Bus
Specification, Revize 2.2 pro napétovy standart 3.3-V pracujici na frekvenci
66 MHz

e Podpora pfipojovani za béhu

e Zabudovany JTAG (Joint Test Action Group), BST(boundary-scan test)
systém vyhovujici standartu IEEE Std. 1149.1-1990

e Systém ISP vyhovujici standartu IEEE Std. 1532

2.2  Vlastnosti zvoleného obvodu EPM240

Obsahuje 240 logickych hradel

Obsahuje 192makrobumék

Az 80 vstupné vystupnich uzivatelskych pint

Pouzité pouzdro 100-pinové TQFP

rozméry obvodu 16 mm x 16 mm, rozestup pint 0,5 mm

Napajeni jadra napétim 3,3 V nebo 2,5 V

Napajeni vstupné-vystupnich bloka standardy 1,5V, 1,8 V.25V 33V



2.3 Konfigurace obvodi MAX 11

V této kapitole jsou pouzity informace z pramenu [3]. Konfigurace obvoda trady
MAX II se provadi ptes rozhrani JTAG (IEEE Std. 1149.1). Toto rozhrani se sklada ze
Ctyt signalt. Jsou to TDI (Test Data Input) slouzici pro vstupni data, TMS (Test Mode
Select) slouzici pro volbu stavi programovani, TCK (Test Clock), ktery slouzi jako
hodinovy signal a TDO (Test Data Output) zafizuje odesilani dat zpét popiipadé do
dalsiho obvodu v fetézci. Pies rozhrani JTAG je mozné programovat vice obvoda
zaroven. Vyuziva se k tomu zapojeni obvoda za sebe do fetézce. Signaly TMS, TCK
jsou zapojeny do kazdého obvodu paralelné a signaly TDI a TDO jsou zapojeny do
série.

V této praci se budu zaméfovat na moznost programovani za uziti externich
programatort. Pripravek by mélo byt mozno naprogramovat pies programator od
spoleCnosti Altera. Mezi n¢ patti Altera ByteblasterMV, MasterBlaster, ByteBlaster II a
USB-Blaster cables. Tyto programatory by méli byt navrzeny pro tyto obvody CPLD,
takze neoCekavam problémy jejich pouziti a funkce. A jako druha moznost konfigurace
bude pres programator PRESTO od spoleCnosti ASIX. Tento programator patfi
momentalné k dosti pouzivanému zafizenim, a to hlavné z divodu Siroké moznosti
programovani nejrizn€jsich programovatelnych obvodu.

2.3.1 Programator PRESTO

V této kapitole jsou pouzity informace z pramenu [4]. Pro programovani soucastek
pfes rozhrani JTAG timto programatorem slouzi program snazvem JTAG SVF
PLAYER. Je s nim mozné programovat a testovat soucastky, pro které existuje software
poskytujici data ve formatu SVF nebo XSVF. To jsou naptiklad obvody CPLD
spoleCnosti Altera, Xilinx, a dal§i. Format XSVF se vyhradné vyuziva pro obvody
spoleCnosti Xilinx. Nas bude zajimat format SVF.

U programatoru PRESTO na nas ¢eka jediné omezeni. Pro programovani pies tento
programator je potieba vygenerovat SVF soubor a nasledné ho nahrat do obvodu pies
dalsi software, ktery dodava ASIX. Presnéji pfes JTAG Player. Dfiivéjsi problémy
s programovanim pomoci PRESTA uz byly odstranény.
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Obrazek 2.1 Zapojeni programatoru PRESTO (prevzato z [4])

* Signal selectable se mize chovat jako SCK nebo TRST popsany v SVF souboru
nebo muze byt definovany uzivatelem (log.1, log.0, tieti stav, rizny béhem
programovani a po ném)



3 NAVRH SCHEMATU PRiPRAVKU

| Konektor napajeni

-

=

+5V

Stabilizator napéti
pro displej
3.3 V-500 mA

Stabilizator napéti
pro CPLD
3,3 V- 500 mA

Konektor
programovani
Altera

Konektor
programovani
PRESTO

Oscilator 50 MHz

Oscilator 1 kHz

3.1 Napajeni

Napajeni celého pfipravku je navrzeno pro adaptér +5 V. Toto napéti je dale
stabilizovano dvéma stabilizdtory LF33, které vstupni napéti 5 V stabilizuji na 3,3
V. Tento stabilizator dovoluje maximalni proudovy odbér 500 mA. Jeden stabilizator je
uzit pro napajeni 7segmentového displeje. Druhy stabilizator je uréeny pro napajeni
obvodu CPLD a vsech periferii. Zapojeni stabilizatoru je navrzeno podle doporuceného
zapojeni udaného v dokumentaci stabilizatoru. Kazdy napéajeci vstup CPLD je osazen
kondenzatorem o kapacité 100 nF, aby se ziskalo stabilné¢jsi napéti, jelikoz tyto obvody

> Tsegmentovy
Sestimistny
multiplexné fizeny
displej

12 vystupnich
signalizacnich diod

12 vstupnich
prepinact

4 tladitka s volbou
oSetfeni zakmita

Konektor pro
externi I/0 zafizeni

!

Tlacitko
hodinového
— signalu

Obrazek 3.1 Blokové schema pripravku

jsou na to citlivé. Zapojeni stabilizatort je zobrazeno na obrazku 3.2.




t

Obrazek 3.2 Zapojeni stabilizator

3.2 Programovani obvodu CPLD

Pro programovani jsou z CPLD vyvedeny dva konektory, které slouzi
k pfipojeni externich programatorti. Konektor snazvem PRESTO je pro pfipojeni
programatoru PRESTO spolecnosti ASIX. Konektor nazvany ALTERA-PARALLEL je
pro pfipojeni programatoru spole¢nosti Altera. Piny jsou rozmistény podle dokumentace
k programatoriim. Zapojeni lze vidét na obrazku 3.3.

—I‘\
>
|

Obrazek 3.3 Zapojeni programovani
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3.3  Oscilatory

Pro vstup hodinového signalu je navrzen oscilator o frekvenci 50 MHz, ktery je
zamyslen jako hlavni zdroj kmito¢tu. Zapojeni je prevzato z doporuceného zapojeni od
vyrobce. Poté je zde navrzen oscilator o frekvenci 1 kHz, ktery je vytvoren z obvodu
74HC14D, coz je invertovany Schmittiv obvod. Tento oscilator je zde pouzit pro fizeni
multiplexniho displeje. To lze vyfesit i pomoci oscilatoru 50 MHz ale zvolil jsem tuto
moznost kvuli plnému vyuziti obvodu 74HC14D. A jako posledni moZnost vstupu
hodinového signalu je zde pouzito tlacitko s oSetfenim proti zakmitim, které mize
slouzit ke krokovani programu v obvodu CPLD.

R

c==

»» 7222164

Obrazek 3.4 Katalogové zapojeni oscilatoru (prevzato z [5])

1 1

T ~ 0.8RC

Rezistor R je zvolen na 130 Q, takze dosazenim a upravou dopocitame
kondenzator C, abychom dosahli frekvence 1 kHz.

1 1
"~ 0,8fR 0,8-1000-130

C

=9,6 uF

[

_{I ==

ik

Obrazek 3.5 Zapojeni oscilatoru

|
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3.4  Vstupni prepinace

Pro demonstraci vstupnich signala jsem pouzil sestavu 12 piepinacu. Ty svym poctem
muzou reprezentovat binarni hodnotu az 4096. Zapojeni je zobrazeno na obrazku 3.5

| =AESE )

—
| =AAEL )

—1

1 T R
—
| =AESS )

—

| =SS )

—
| =AEEL )

—

1 ¥ R
—
| =AAS )

—

| =AESE )

—
| =AAEL )

—1

| =AEES )

—
| =AESS )

Obrazek 3.6 Zapojeni prepinacu

Zapojeni je navrzeno jako de€li¢ napéti. Pfi rozepnutém stavu spinacl je na vstup
ptivedeno napéti 3,3 V pres rezistor 10 kQ, coz omezuje proud vstupujici do obvodu.
V pfipadé nastaveni nizké urovné€ vstupu bez omezeni proudu, by mohlo dojit
k pretizeni obvodu CPLD. Tim padem je proud omezen na hodnotu

_ Vcc _ 3,3
~ R37 10000

V tomto piipadé jde o reprezentaci vysoké urovné. Nizkd uroven je definovana
sepnutym prepinacem, kdy dojde k uzemnéni obvodu pres rezistor o hodnoté 470 Q.
Tim ziskame dfive zminény déli¢ napéti. V tomto pripadé na vstup CPLD je pfivadéna
nizka aroven o velikosti napéti
R29 470
=——Vec=—r—F—
R29 + R37 470+ 10000

= 330uA

U, 3,3 =0,148V
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3.5  Vstupni tlalitka

Dalsi vstup signali je vytvoren Ctverici tlacitek, u kterych je mozna volba oSetfeni
mechanickych zakmitd. V pfipad€ nepouziti oSetfujici volby, lze zakmity odstranit na
urovni softwaru. Volba zapojeni tlacitek je rozhodovana pomoci propojek.

Doba nestability tlaitek se vétSinou pohybuje vrozmezi 100 ns az 10 ms.
V nékterych pripadech i vétsi. Pro oSetfeni zakmita jsem zvolil hodnotu 1 ms. Pfi volbé

rezistort na 10 kQ a 100 Q, jsem dopocital hodnotu pouzitého kondenzatoru pomoci
vztahu

1 1
C= =
(R21+ R22)-f (10000 + 100) - 1000

Z toho diavodu jsem zvolil hodnotu kondenzatoru na 100 nF. Zapojeni je
znazornéno na obrazku 3.7.

=99 nF

b 7

; L]

¢

LhL |
u

_|
_|

S
:
_|

}_7

Obrazek 3.7 Zapojeni tlacitek
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3.6 Vystupni LED diody

Jako demonstraci vystupnich dat jsem navrhl 12 LED diod. Pocet je totozny s poctem
prepinaci. Diody jsou pfipojeny na napajeci napéti 3,3 V pres rezistor 330 Q pro
omezeni proudu diodou na 10 mA. LED diody sviti ve chvili nastaveni na obvodu
CPLD nizké trovné na vstupu. Zapojeni je na obrazku 3.8.

1 1
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1 1
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1 1
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1 1
[ | —
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Lo
1 1
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Uig
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N I
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1 | —
N —
Y
1 | —
N —
g
1 1
™~ | S|
e
1 ' p— |
N L
e

Obrazek 3.8 Zapojeni LED diod

3.7  Multiplexné Fizeny 7segmentovy displej

V navrhu jsem pouzil Sestimistny 7segmentovy multiplexné fizeny displej se spolecnou
anodou. Pfedem jsem oveéfil kapacitni naro¢nost fadi¢e displeje na obvod CPLD. A
fadi¢ zabiral pfiblizné 10 procent kapacity obvodu. Z toho divodu jsem se rozhodl pro
pouziti multiplexné fizeného displeje. Pro omezeni proudu segmentem jsou pouzity
rezistory o velikosti 330 Q. Tim dosahneme proudu 10 mA na segment. Je zde pridana i
moznost manualniho odpojeni napajeni displeje pomoci propojky. Spinani napéjeni
bylo feSeno pres tranzistory BC 817 a BC 807 aby nedochazelo k velkému zatizeni
CPLD. Nap4jeni je ze samostatného stabilizatoru. Schema zapojeni je na obrazku 3.9.
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Obrazek 3.9 Zapojeni displeje

3.8 Konektory pro externi I/O zarizeni

Jsou pouzity 3 konektory. Kazdy obsahuje i napajeni 3,3 V a pripojeni GND. Dvojice
konektort EXT1 a EXT2 maji vyvedeno 14 a 15 uzivatelskych pini obvodu CPLD. A
konektor EXT3 ma vyvedeno 5 uzivatelskych pind. To znamena, ze celkem je mozné
vyuzit az 34 uzivatelskych pini obvodu CPLD pro pfipojeni externich zafizeni.
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4 NAVRH DESKY PLOSNYCH SPOJU

Navrh desky plosnych spoji probéhl podle doporuceni uvefejnénych na webu
UREL VUT Brno a podle doporuceni vedouciho prace.

INE

AR

ZNIRS

& 5 @ °s'€ i 3
0 : o / K\
i (e
............ 1
NE 000

Obrazek 4.2 BOTTOM vrstva navrzené desky
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5 NAVOD NA PRACI S PRIPRAVKEM

Pro praci s pfipravkem jsem vytvofil dvé Sablony. Jedna Sablona je se
schematickou vrcholovou jednotkou. Druhd pak s textovou. Obé §ablony jsou ulozeny
na doprovodném CD. Budeme se zabyvat praci se Sablonou se schematickou
vrcholovou jednotkou.

| & sablona_sch.bdf* [x]
Hsiea-c[FEAVADL-OIINNNOONERAS

delicka_kmitoctu L isp
| e -~ clkso mhertz |— : ~{ cikso dgit. 0] o T e T TN
T : B : etz hertz seql7..0] AT Sr 00 =]
| hertz {— — A5.01
: . . . ¢ inst g .
| — C[5.0)
| —t D[5..0]
| CEH G — 5.
| ey = FI5.01
L lu =
[ANE [y~ PIN_98
PIN_97
I PIN_96
[ANE - e
AN 62
S A g
TiH I 1= ‘—I
AN_14 s BRI BT 10]
| P 1 e 111 i N P e
W VEC o= T Nk
| B U e 11 i
[AN_100
[ TRt =
At
lidzalkmit S 1

AN_2

Obrazek 5.1 Schematicka vrcholova jednotka Sablony

5.1  Postupy pro praci se Sablonou v QUARTUS 11

Po spusténi softwaru QUARTUS II se ndm zobrazi nabidka na vytvofeni nového
projektu nebo otevieni stavajiciho projektu. Zvolime otevieni stavajiciho projektu. A
vybereme nasi Sablonu s nazvem “sablona_sch.qpf™.

5.1.1 Prejmenovani projektu

V tuto chvili mame otevienou Sablonu. Ale abychom neméli vSechny projekty se
stejnym jménem, provedeme nasledujicich par kroki pro pfejmenovani.

Z divodu, ze Quartus nedisponuje primo funkci Save Project As, rozklikneme si
nabidku Project a zvolime polozku Copy Project. Otevie se nam nabidka pro zvoleni
nového umisténi projektu a nazev projektu. V naSem piipadé zvolime jméno “vzor sch*
a potvrdime. V pfipad€ zvoleni mista projektu, které neexistuje, budeme dotazani, jestli
se ma slozka vytvoftit. Zvolime Ano. Timto krokem se nam vytvofil na novém umisténi
projekt s novym jménem. Ale potrad se nam zobrazuje vrcholova jednotka s nazvem
starym. Proto v okn€ Project Navigator prepneme na zalozku Files a dvojklikem

18



otevieme Sablona sch.bdf. Nasledné provedeme ulozeni pod jinym nadzvem. V naSem
ptipadé pod jménem vzor sch.bdf. Automaticky se ndm tento nové vytvoreny soubor
ptidal do projektu. Jelikoz nam nyni zastal v projektu i pivodni soubor, tak na n¢j
klikneme pravym tlacitkem mysi a zvolime odstranéni z projektu. Nyni klikneme na
nami vytvofeny soubor vzor sch.bdf pravym tlacitkem a zvolime ho za vrcholovou
jednotku. Nyni mame projekt vytvoren. Pod hlavni nabidkou se nam zobrazuje
posledni vzpominka na §ablonu. To znaci jaké nastaveni projektu je aktualni. V naSem
ptipadé kam jsou pfifazené piny na pouzdie obvodu, atd. Jestli ndm tato vzpominka
vadi, muzeme ji zménit. V menu rozklikneme Project a zvolime polozku Revision.
Otevie se nam okno, v ném poklepame na polozku New Revision. Vysko¢i nam okno ve
kterém nastavime nové jméno, v nasem piipadé vzor sch a v polozce Based On
Revision ponechame sablona sch. Tim zajistime totozné nastaveni se Sablonou.
Zkontrolujeme, jestli mame zaSkrtnuté moznosti pro Copy Database a Set As Current
Revision. Poté potvrdime OK. Vidime, ze se nam pridal novy profil a Ze ten stary nam
tam zustal. Ted je jen na nas jestli ten stary smazeme nebo ne. Timto nam uz nestoji nic
v cesté pokracovat v navrhu.

5.1.2 Seznameni s vrcholovou jednotkou

Nyni si pfedstavime schematickou vrcholovou jednotku. Na obrdzku 5.1 vidime
vytvorené dva bloky. Zdrojové kody jsou uvedeny v ptiloze B./ a B.2.

Prvni blok nazvany délicka kmitoctu slouzi jako déli¢ kmitoctu. Na vstupu mame
oscilator o frekvenci 50 MHz. Na vystupu pak 1 MHz, 1 kHz a 1 Hz.

Druhy blok je nazvan jako disp a funguje jako fadic multiplexné fizeného
7segmentového displeje. Vstupni signaly jsou pojmenovany pismeny A, B, C, D, E, F,
dp, clk50 a khertz. Vstupy A az F jsou Sestibitové a kazdy vstup slouzi pravé jednomu
digitu na displeji. Kazdy bit reprezentuje prave jen jeden segment z celé Cislice. Vstup
dp je taktéz Sestibitovy a kazdy bit reprezentuje pravé jednu tecku ke kazdému digitu.
Pomoci vstupu c/k50 je frekvenci 50 MHz obnovovany vstupni udaje ze vstupi 4 — F' a
dp. Vstupem khertz je s frekvenci 1 kHz postupné piepinané zobrazované digity na
displeji. Na Sabloné je kromé vySe popsanych blokd i mnoho vstupt a vystupt. Ty
slouzi minimalné k ilustraci vSech moznych periferii, které se daji vyuzit pro navrh.
V jiném ptipadé je mozné vstupy a vystupy pfimo vyuzit a propojit je s navrhem.

5.1.3 Vytvoreni vlastniho konstrukcniho bloku

Pro nas navrh budeme potiebovat vytvorit dalsi blok, ktery bude plnit funkci,
kterou mu nadefinujeme. Pro vytvoreni, v nabidce File klikneme na moznost New.
V okné¢, které se nam zobrazi, vybereme VHDL File a potvrdime OK. Otevie se ndm
soubor, ktery si nédsledn€ ulozime pod ndmi zddanym nazvem. Automaticky se nam
prida do projektu. Nyni nas ¢eka sestrojeni konstrukce. Zapis je ¢lenén nasledujicim
zpusobem.
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LIBRARY ieee;
USE ieee.std logic 1164.ALL;
USE ieee.std logic unsigned.ALL;

Entity Counter IS

PORT (
hertz, Smer, Areset: IN std logic;
Sreset, Nacteni, Cen: IN std logic;
Din: IN std logic vector (3 downto O0);
Count: OUT std logic vector (3 downto O0)

) ;
END Counter;

ARCHITECTURE CountArch OF Counter IS
SIGNAL CntInt: std logic vector (3 downto 0):= "1010";

BEGIN
PROCESS (hertz, Areset) BEGIN
IF Areset = 'l1' THEN
CntInt <= "0000";
ELSIF (hertz'event AND hertz = '1l') THEN
IF Sreset = '1l' THEN
CntInt <= "0000";
ELSIF Nacteni = '1l' THEN
CntInt <= not Din;
ELSIF CEn = '1l' THEN
IF Smer = '1' THEN
CntInt <= CntInt + 1;
ELSE
CntInt <= CntInt - 1;
END IF;
END IF;
END IF;
END PROCESS;
Count <= not CntInt;
END CountArch;

Kdyz mame vytvofenou konstrukci, tak soubor ulozime a provedeme Analyzu a
syntézu, kterou spustime dvojklikem v okné Tasks na Analysis & Synthesis. Pokud je
v§e v poradku mizeme pokracovat ve tvofeni schematického bloku. V okné projektu
pravym tladitkem klikneme na nami vytvoreny soubor a vybereme moznost Create
symbol Files For Current File. Jelikoz cela Sablona potfebuje obnovit schematické
symboly vSech blokt, provedeme tento krok i pro ostatni bloky. V dal§im kroku
prejdeme do vrcholové jednotky. Klikneme do schematu pravym tladitkem a zvolime
Update Symbol Or Block. Dvojklikem na levé tlaitko nyni otevieme okno s nazvem
Symbol. V okné rozklikneme polozku Project, kde vybereme symbol, ktery jsme pred
chvili vytvorili. Zkontrolujeme, jestli nemame zaskrtnuté policko Insert Symbol As
Block a pokud neni zaskrtnuté tak potvrdime OK. Symbol nasledné vlozime do
schematu. Vratim se jesté k oknu Symbol. V ptipadé, ze potiebujeme do projektu vlozit
néjaky dalsi symbol, ktery patfi k béznym funkcim jako na ptiklad AND, OR a mnoho
dalsSich miZeme si vybrat zknihovny Quartus. V tomto pfipadé nebudeme hledat
v polozce Project ale v polozce Libraries. Po nalezeni toho co potiebujeme, se
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postupuje dale stejné jako pfi vlozeni nami vytvotfeného bloku. Kdyz se vratim zpatky
do vrcholové jednotky, kde uz mame vlozen nas§ blok, je potfeba ho pfipojit. Pfipojuje
se kliknutim a drzenim levého tlaCitka mysi na vyvod bloku a tazenim k vyvodu,
kterému ho chceme pfipojit. Tady musime déavat pozor. V pfipad€, ze chceme pfipojit
sbérnici naptiklad k symbolu napajeni, musime pfipojovat ve sméru od sbérnice
k napdjeni. V pripadé opacném se tyto dva objekty taktéz spoji, ale ne pomoci
sbérnicového spoje ale jen jediného spoje, ktery nam nasledné pti syntéze bude hlasit
chybu z divodu, Ze nejsou vSechny vstupy piipojeny. V tomto ohledu podle mého
nazoru je navrhovy systém trochu nesikovny. V pfipadé nutnosti ptipojeni vice zdroju
do sbérnice, vyvedeme kousek sbérnice, tu nasledné pojmenujeme jmény signalt
oddélené Carkami, které chceme pfipojit. V piipadé nevyuziti nékterych LED diod na
desce je potfeba je v navrhu pfipojit na napajeni, protoze LED diody, kdyz na né
pfivedeme logickou nulu tak sviti. Pfipojenim na logickou jednicku dosdhneme
nesviticich LED diod, které nejsou pouzity.

— Dir
— Areset
— Sreset
.gsw{ﬂ..O] D—%%CL
1 o Din3..0]

Obrazek 5.2 Pfipojeni vice zdroji do sbérnice

Nyni muazeme provést syntézu, ktera nam odhali, jestli se nam nékde nachazi
syntakticka chyba.
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5.1.4 Prirazeni vyvodi

Ptifazeni pint lze v programu Quartus II provést tfemi zptsoby. Prvni zpisob je
ptes Pin Planner, v kterém je graficky zobrazené pouzdro obvodu. Pro nazornost je to
dobry zpusob, ale v ptipad€ zadavani vice pind je to zpusob trochu zdlouhavy.

& Pin Planner - CyUsers/rodina/Des

Fle Edit View Processing Tools

|Groups
@Namedw - smmmEmmmmY mn e
. 2000000,/ 7000000000
B Node Name Direction Location 9
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@, | b @ Din3..00 Input Group -9
@ > ¥ diod[11..4] Qutput Group @ Topiicw
> T seg[7..0] Output Group i) Wire Bond
=g <<new group>> : @
el ‘:@
o |
a
-1
i :®
-
e .0 MAX Il
= -
= - EPM240T10015
ﬁ 118
& "
ﬁ; 1:0
< | n | »
=i T B i Teitter:[Ping: =
8% Named: - [fey]Edie[ 3¢ ][ [Fiter: Pins: &l
e Node Name Direction Location 1/0 Bank 1/0 Standard Reserved Current Strength
Areset Input PIN6 1 3.3VLV..default 16mA (default) E
[ default) (defautt)
2 @ Input PIN_3 1 33VLV..default) 16mA (default) -
% B dks0 Tnput PIN_12 1 3.3VLV._ default) 16mA {default)
» F Count[3] Cutput PIN_85 2 3.3V LV._ default) 16mA {default)
= | Count(2] Cutput PIN_86 2 3.3V LV..default) 16mA (default)
o Count[1] Output PIN_87 2 33VLV..default) 16mA (default)
4 Count[0] Cutput PIN_88 2 33VLV._default) 16mA (default)
o digit[5] Cutput PIN_36 1 3.3V LV._ default) 16mA {default)
o digit[4] Cutput PIN_35 1 3.3V LV._ default) 16mA {default)
o digi[3] Cutput PIN_34 1 3.3 LV..default) 16mA (default)
| diit(2] Cutput PIN_33 1 33VLV..default) 16mA (default)
£ | dgit[1] Cutput PIN_30 1 33VLV..default) 16mA (default)
F /[P digit[o] Qutput FIN_29 1 3.3VLV._ default) 16mA {default) -
0%  00:00:00

Obrazek 5.3 Pfifazeni vyvodu pres Pin Planner

Dalsim zpisobem je pomoci Assignment Editoru, ktery je v podstaté obdobny
zpusob piitazovani pina jako od Xillinx ve formé UCF souboru. A poslednim zptsobem
je pomoci 7CL scriptu, ktery lze vygenerovat pres Quartus a nasledné jej jen lehce
upravit podle nasich potieb. Pro moji osobu piisel jako nejprivetivejsi zplsob
pfifazovani prave Assignment Editor.

V nasi Sabloné jsou uz vSechny piny pfifazeny a tak uz nam zbyva jen upravovat
pomoci Assignment Editoru nazvy pinti pro konstrukci. Zptisoby pfifazovani pini jsou
intuitivné feSeny, takZe neni potieba nikterak do hloubky popisovat zpusob.
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Window Help &

ew  Tools |
<<pew>> v [V Filter on node names: = - Category.' !

= From To Assignment Name Value Enabled Entity Comment Tag B
B dkso Location PIN_12 Yes

4 digit[5] Location PIM_36 Yes
I digit[4] Location PIM_35 Yes
4 digit[3] Location PIM_34 Yes
o digit[2] Location PIM_33 Yes
& digit[1] Location PIM_30 Yes
£ digit[d] Location PIM_29 Yes
4 diod[11] Location PIMN_93 Yes
¥ diod[10] Location PIN_97 Yes
¥ diod[9] Location PIM_96 Yes
4 diod[3] Location PIM_95 Yes
% diod[7] Location PIM_92 Yes
€ diod[s] Location PIM_51 Yes
& diod[5] Location PIM_30 Yes
4 diod[4] Location PIM_89 Yes
4 seq[7] Location PIMN_44 Yes
4 seqls] Location PIMN_43 Yes
£ seg[s] Location PIN_42 Yes
4 seqld] Location PIM_41 Yes
& seq[3] Location PIM_40 Yes
o seqfZ] Location PIM_39 Yes
I seqli] Location PIMN_38 Yes
4 seq[l] Location PIN_37 Yes

L AL SENENERE LN N N SERLN AN N NE AL R NS

BNRBEBENEHERRREBE®EMNEEMNE

0% 00:00:00

Obrazek 5.4 Pfifazeni vyvodu v Assignment Editoru

5.1.5 Programovani pripravku

Ve chvili jak mame spravné pridéleny piny, tak ndm nezbyva nic jiného nez cely
projekt zkompilovat dvojklikem na Compile design v okné Tasks. V piipadé kdyz
dojde k uspésnému zkompilovani nasi konstrukce, tak se automaticky vygeneruje
soubor pro zapis do obvodu, ktery méa koncovku pof (programmming output file). Pro
nahrani konstrukce do obvodu slouzi program s nazvem Programmer, ktery spustime
dvojklikem na polozku Program Device v okné Tasks. Tim, ze ho spoustime piimo
pres Quartusu se nam automaticky nacte i soubor s programem. V piipadé ze mame
programator, ktery je podporovan softwarem Programmer, tak postupujeme
nasledujicim zptusobem. Nyni nas Ceka detekce a nastaveni naseho programatoru,
kterym chceme naprogramovat obvod. Klikneme na tlaCitko Hardware Setup a
vybereme programator, ktery mame pfipojeny k pocitaci a potvrdime OK. Nyni staci uz
jen kliknout na tlacitko Start v nabidce na levé strané okna. Provede se nahrani
konstrukce do obvodu. A jestli je vSe v poradku, tak se nam zobrazi okno s potvrzenim
uspéSného nahrani programu.
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E)

é Hardware Setup...| No Hardware

[7] Enable real-time ISP to allow background programming (for MAX II and MAY ¥ devices)

File Device Checksum Usercode Program/ Blank- Examine Security  Erase Isp IPS File
Configure Check Bit CLAMP
countdbit.pof EPM240T 100 00188511 FFFFFFFF ] [l
cFm @
UEM 5]
— -
X Delet= Create JAM, JBC, SVF or ISC file ==
- Lo  JBC, e
(2 Add File...
File name:  count4bit. svf
B change File = | 7 e
4 File format: | Serial Vector Format (.svf) - b
@l Save File Cperation Programming options
(£ Add Device.... (@ Program [ Blank-check
) Verify Verify
4up
w o Clock frequecy
TCK frequency: 30 MHz
uuuuuuuuu
EPM240T100 Supply voltage: [3‘3»/0\!5 ']
b ToO
4 e
| OK Cancel |

Obrazek 5.5 Generovani SVF souboru

V ptipadé programovani piipravku programatorem Presto od firmy ASIX,
nebudeme klikat na tlacitko Hardware Setup, ale v menu File klikneme na moznost
Create JAM, JBV, SVF or ISC File. Zobrazi se nam okno, kde nastavime format
souboru na Seridl Vector Format (.svf) a v kolonce 7CK frequency nastavime jen 3
MHz z ptvodnich 18 MHz. To ztoho duvodu, ze programator Presto podporuje
maximalné 3 MHz hodiny. V pfipadé pokud zanechame 18 MHz, taktéz se nam podari
obvod naprogramovat, ale bude pribéh programovani zdlouhavéjsi. Kdyz mame vse
nastaveno, tak stiskneme OK. Tim se nam vygeneruje SVF soubor s instrukcemi.
K dokonceni programovani potiebujeme si nainstalovat software od vyrobce ASIX
snazvem JTAG Player. JTAG Player je uzivatelsky velmi jednoduchy program.
V prvni fadé rozklikneme polozku Options a vybereme polozku Select Presto.
Zaskrtneme programem identifikované zafizeni a potvrdime. Poté uz jen v nabidce File
klikneme na Open and Process a vybereme soubor .svf, ktery jsme si nechali
vygenerovat a potvrdime. Okamzité se zaCne programovat obvod.

- _ _
B IJTAG SVF Player for PRESTD 2.3 ™

-

EEE

File Options Help

Obrazek 5.6 JTAG SVF Player
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5.2  Postupy pro simulace a analyzy VHDL konstrukei

5.2.1 Funkéni simulace

V prvé tfadé budeme muset povolit generovani souboru pro funkéni simulaci. To
provedeme v nabidce Assignments -> Settings. Vybereme kategorii Simulation, Jako
prostiedek nastavime ModelSim-Altera. Rozklikneme moznost More FEDA Netlist
Writer Settings. Tady nastavime Generate third-party EDA tool command script for
RTL function simulation a také moznost pro gate-level simulation, tim ziskame
vygenerovany soubor i pro post-fit simulaci. VSe potvrdime. Vygenerujeme si §ablonu
na Test Bench. Dale budu pouzivat vyraz ben¢, ktery je uz vcelku zdomacnély pojem.
V menu Processing -> Start -> Start Test Bench Template Writer, tim se nam
vygeneruje benC. Nyni si spustime Modelsim Altera. Ptejdeme do nabidky File ->
Change Directory, kde si nastavime cestu k naSemu projektu. Poté v menu File -> New
-> Library v okné, které se ndm zobrazi vybereme posledni moznost 4 new library and
a logical mapping to it a zadame nazev knihovny, ve které budeme mit soubory pro
simulaci. Po potvrzeni pokratujeme na menu Compile -> Compile. Zde si vybereme
nami stvorenou knihovnu a oznac¢ime soubory *vho a *vht. Potvrdime a pravym
tlaCitkem klikneme na nas ben¢ v knihovné a vybereme Edit. Nyni nas Ceka uprava
vygenerovaného bence a napsani vstupnich stimult pro simulaci. Pro piiklad dokladam
zdrojovy text k benci.

LIBRARY ieee;
USE ieee.std logic 1164.all;

ENTITY operator vhd tst IS
END operator vhd tst;

ARCHITECTURE operator arch OF operator vhd tst IS

SIGNAL A : STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL A_Out : STD_LOGIC_VECTOR( DOWNTO O0) ;

SIGNAL B : STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL B Out : STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL C Out : STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL tll : STD_LOGIC:=' '

SIGNAL tl2 : STD_LOGIC:='O';

SIGNAL tl13 : STD_LOGIC:='O';

SIGNAL tl4 : STD_LOGIC:='O';

SIGNAL tl15 : STD_LOGIC:='O';

SIGNAL kH : STD_LOGIC:='O';

COMPONENT operator

PORT (

A in std logic vector (3 downto 0);
B : in std logic vector (3 downto 0);
tll, tl2, tl13, tl4, tl15: in std logic;

C out: out std logic vector (3 downto 0);
A out: out std loglc vector (3 downto 0);
B out: out std loglc vector (3 downto 0);
kH: in std logic
)
END COMPONENT;
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BEGIN

i1

operator

PORT MAP (

)7

Clock GEN

A => A,

A out => A out,

B => B,

B out => B out,
C out => C out,
tll => tl11,
tl2 => tl2,
tl3 => tl13,
tld => tl14,
tl5 => tl15,

kH => kH

loop
kH <=
kH <=
end loop;

IOI;
lll;

PROCESS BEGIN

wailt
wailt

END PROCESS Clock GENj;

always
A <= "1100"
B <= "0011"

Wait for 10ms;

tll
tl2
tl3
tl4
tl5
END
END

Ve chvili jak mame benc pfipraveny, tak ho ulozime a zkompilujeme ho. Poté uz
staci jen dvakrat kliknout na test bech v knihovné a spusti se. Nyni si jen tdhnutim mysi
pridame kontrolované signaly z okna Objects do okna Wave. Pokud neni zobrazeno
okno waves automaticky, tak si ho spustime v menu View -> Wave. Ted uz nezbyva

<= '1'; wait
<= '1'; wait
<= '1'; wait
<= '1'; wait
<= '1'; wait

PRCESS BEGIN

for
for
for
for
for

PROCESS always;
operator arch;

lms;
lms;
lms;
lms;
lms;

for
for

tll
tlz2
tl3
tl4
tl5

500
500

us;
us;

IOI.
IOI.

IOI

IOI.
IOI.

nic jiného nez nastaveni délky simulace a spusténi.
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wait
wait
wait
wait
wait

for
for
for
for
for

Ims;
Ims;
Ims;
Ims;
Ims;



1m| Wave - Defauit ——— ——
[D-@B-8 sn@B02 [0-#E% || SHiRB|G4e+@F vmdUBBROHP B YNE||R 1
[2E*Net £S5 3-423] > 1G] RQQR]| [T 4 W

/bit_operat_vhd_tst/B

bit_operat_vhd_tst/A_out
# _ Jbit_operat_vhd_tst/B_out
“  bit_operat_vhd_tst/ti1

Jbit_operat_vhd_tst/i2
Jbit_operat_vhd_tst/ti3
Joit_operat_vhd_tst/d4
/bit_operat_vhd_tst/ti5
bit_operat_vhd_tst/C_out

Obrazek 5.7 Prubéhy simulace v ModelSim

Nyni v okné Waves si mizeme zkontrolovat, jestli nam nase konstrukce opravdu déla to
co ma. V pripad€, ze nedéla tak timto zptisobem lze rychleji dohledat zdroj problému,

vvvvvv

konstrukci.

5.2.2 POST-FIT Simulace

Simulace Post Fit neboli simulace po rozmisténi je v podstaté simulace bence do
kterého jsou zapocitany i Casové prodlevy signalovych drah. Proto taky postup je
obdobny s ben¢em s tim rozdilem, ze u Post Fit simulace je pouzit jesté vygenerovany
soubor *.sdo, ktery nese informace o ¢asovych zpozdénich. Postup je nasledujici.
Jelikoz jsme si uz u bence povolili generovani i souboru *.sdo, tak mizeme pracovat
pfimo v programu ModelSim. Po vytvofeni nas§i knihovny a zkompilovani souboru
*vho a *vht jako u bence. Klikneme v menu na Simulate -> Start Simulation. Otevie
se nam okno, kde si vybereme nasi knithovnu a ozna¢ime soubor s benc¢em. Pfejdeme na
zalozku SDF, kde pomoci tlacitka Add vybereme vygenerovany soubor s ¢asovym
zpozdénim a potvrdime. Poté zaSkrtneme moznosti Disable SDF warnings a reduce
SDF errors to warnings. Tim potla¢ime chyby, které nam vyskoci v pfipad€, Zze
nemame piipojené né€jaké piny v navrhu. Potvrdime OK. Nyni se nam spustila post fit
simulace a nasledujici prace je totozna s benCem. V mém piipadé pfi provedeni post fit
simulace pro konstrukci s bitovymi operacemi se casové zpozdéni nikterak neprojevilo.

5.2.3 Staticka Casova analyza

Pro vytvoreni statické Casové analyzy je potieba provést Place&Route. Poté
v okné 7asks rozklikneme polozku 7imeQuest Timing Analysis a dvakrat poklepeme na
polozku TimeQuest Timing Analyzer. Tim se nam spusti 7imeQuest. Budeme dotazani,
jestli chceme vygenerovat SDC soubor ze souboru (OSF. To potvrdime. Nyni
v programu TimeQuest v okn€ Tasks spustime Report Datasheet. Tim se nam spusti
analyza a nasledné zobrazi vypis ¢asovych zpozdéni nasi konstrukce.
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File View Netlist Constraints Reports Script Tools Window Help @

0% 00:00:00 Ready

Obrazek 5.8 TimeQuest - Zobrazeni vysledki po spusténi Report Data

[Report o8 e T O-n
ER TimeQuest Tiring Analyzer Summary Data Port CockPort  Rise  Fal  ClockEdge  ClockReference
4. 'S Batacheet Report 1 CEn hertz 5187 5187 Rise hertz
B3 setup Times 2 4 DnM hertz 4497 4497 Rise hertz
B3 Hold Times 1 Din[0] hertz 3.047 3.047 Rise hertz
B3 Clock to Output Times 2 Din[1]  hertz 4497 4497 Rise hertz
Minimum Clock to Output Times 3 Din[2] hertz 3.986 3.986 Rise hertz
B ReportPath 4 Din[3] hertz 3.664 3.664 Rise hertz
3 Dir hertz 7.943 7943 Rise hertz
4 Nacteni hertz 5.377 5.377 Rise hertz
(Tasks CIETE 5 Sreset  hertz 4617 4617 Rise hertz
v (& Open Project... =
3 Netlist Setup
v P Create Timing Netlist
~ P Read SDCFile
v P Update Timing Netlist £
P Reset Design
(2] set Operating Conditions...
3 Reports LY
> (2 Slack
4 {3 Datasheet
B3 Report Fmax Summary
v E¥ Report Datasheet
b (] Device Specific
> (™1 Niannnstic M
(X[ @) Tafo: srrrrrerrrmrmrsnnnrnnrnnnnnrn e s nnnn e nn P ———————— B
g b y Info: nning Quartus II 32-bit TimeQuest Timing Analyzer L\
" £ TREQ: Rtk s e e e e e e e e e AR A =
g < _:v\) m ] 3
| OJ\_Console /\ Histor:

V pfipadé, ze nas zajimaji jen urCité cesty, tak spustime v okné 7asks polozku
Report Path, ktera se nachazi v Custom Reports. Zobrazi se nam okno, kde si pfimo
nastavime cestu. Poté jen potvrdime tlafitkem Report Path. Tim se nam provede

analyza zadanych cest.

Targets

From:
Through:
To:

Paths

Report number of paths:

Maximum number of paths per endpoint: )

Output

Report panel name: -Report Path

[ File name:

[ console

File options

@ Overwrite

Append

Tcl command:  report_path -npaths 1 -panel_name {Report Path}

_W

Open

[ Report path | |

Close ] [ Help ]

Obrazek 5.9 TimeQuest - nastaveni cest pro analyzu
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Parametry statické cCasové analyzy Ize =ziskat 1 pfimo v névrhovém
systému Quartus. Staci V okné Tasks -> TimeQuest Timing Analysis poklepat na
polozku View Report. Spusti se nam zalozka Compilation Report, kde v polozce
TimeQuest Timing Analyzer se nam zobrazi ziskané Casové parametry.

Table of Contents Aol herez |
7 Flow Summary Slack From MNode To Mode Launch Clock Latch Clock Relationship Clock Skew Data Delay
EH Flow Settings 1 3.081 CntInt[3] CntInt[3] hertz hertz 0.000 0.000 3.302
e — 2 3285  Cntint[7] Crtint[2]  hertz hertz 0.000 0.000 3.506

3 4226 Cntint[1] Crtlnt[1]  hertz hertz 0.000 0.000 4.447
&= Flow Elapsed Time 4 4357 Cntint{1] Cntint[2]  hertz hertz 0.000 0.000 4578
B8 Flow 08 Summary 5 4647  Cntint[g] Cntint[3]  hertz hertz 0.000 0.000 4.368
Bl Flow Log 6 4670  Cntint[d] Ctint[0]  hertz hertz 0.000 0.000 4,391
> £ Analysis & Synthesis 7 4957  Cntint[1] Crtint[3]  hertz hertz 0.000 0.000 5.138
- 3 Fitter 3 4091 CntInt[0] Crtint[1]  herz hertz 0.000 0.000 5212
a 4_3 TimeQuest Tining Analyzer 9 5.096 CntInt[d] CntInt[2] hertz hertz 0.000 0.000 LEei Ry
10 5706 Cntint[d] CntInt[3] hertz hertz 0.000 0.000 5.927
E Summary
ER Parallel Compilation
EA clocks

% Fmax Summary
ﬁ Setup Summary
E# Hold Summary
Recovery Summary
Removal Summary
5 Minimum Pulse Width Summary
4 ﬁ Worst-Case Timing Paths
ER setup: hert?
ER Hold: 'hertz'
5 Minimum Pulse Width: ‘hertz'
> @ Datasheet Report
(1 Clock Transfers
B ReportTCCS
Report RSKM
% Unconstrained Paths
j,) Messages
i | TimeQuest Timing Analyzer GUT

Obrazek 5.10 Quartus II - zobrazeni vysledki analyzy

6 VZOROVE VHDL KONSTRUKCE

Pro demonstraci funkce pfipravku jsem vytvofil nasledujici ¢tyfi VHDL konstrukce.
Jejich zdrojové kody jsou uverejnény v priloze. Zde uvadim jen jejich popis funkce.
Vsechny konstrukce jsou plné funkéni a odzkousené a jsou piilozeny na doprovodném
CD.

6.1 Hodiny

Tato VHDL konstrukce funguje jako klasické hodiny. Udaj Gasu je zobrazovan na
7segmentovém displeji ve tvaru HH.MM.SS. Sekundy jsou také zobrazovany pomoci
skupiny LED diod, které blikaji v taktu 1 sekundy. Nastavovani hodin je provedeno
pomoci skupiny prepinacli. Prvni Sestice prepinacli slouzi k nastaveni hodin a druha
Sestice k nastaveni minut. Nastaveni se ulozi po stisku tlacitka tl1.

Zdrojovy kod je v ptiloze B.3
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6.2  Bitové operace

Bitové operace je program, ktery slouzi k demonstraci logickych funkci AND, OR,
EX OR, NOR a negace. Jako vstupy jsem pouzil dva ctyrbitové signaly, které jsou
reprezentovany skupinou piepinaci. Stav vstupt je zobrazovan pomoci LED diod piimo
nad pfepinaci. Vystup bitové operace je zobrazovan pomoci zbylé ¢tvefice LED diod.
Vybér provadéné funkce je volen pomoci pétice tlacitek. Prvni tlacitko tl1 reprezentuje
funkci AND, tlacitko t12 funkci OR, tlacitko tI3 funkci EX OR, tlacitko tl4 funkci NOR
a tlacitko tl5 reprezentuje funkci negace vstupu A.

Zdrojovy kod je v ptiloze B.4

6.3 Prevod BIN to HEX

Tato konstrukce prevadi binarni kod na hexadecimalni. Jako binarni vstup jsou
pouzity prepinaCe. Ty jsou rozdéleny na tii Ctvefice biti. Kazda Ctvefice bith je
pfevadéna na hexadecimalni hodnotu, kterda je nasledné zobrazena na 7segmentovém
displeji. Na displeji prvni tii digity porad zobrazuji nuly a na zbylych tfech digitech jsou
zobrazeny prevody z prepinaci. V tomto programu je jesté vlozena dalsi funkce, ktera
zobrazuje na LED diodach preddefinované posloupnosti podle toho, které tlacitko je
zrovna stlaceno.

Zdrojovy kod je v piiloze B.5

6.4 Citat

Jedna se o Ctyibitovy CitaC¢ s volbou sméru Citani, ktery je dany prvnim v fadé
prepinacu. Cita¢ ma funkci synchronniho i asynchronniho resetu, Asynchronni reset je
na tlacitku tl1, synchronni na tlacitku tl2. Na tlac¢itku tI3 je moznost nacteni pocatecni

rrrrrr

tlagitko tl4. Stav &itaGe je zobrazen na &tvefici LED diod. Citani je provadéno signalem
o frekvenci 1 Hz.

Zdrojovy kod je v ptiloze B.6
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7 ZAVER

V diplomové praci jsem mél za ukol navrhnout a zrealizovat vyvojovou desku pro
préci s obvody CPLD od spole¢nosti ALTERA. Tento bod jsem splnil. Pripravek jsem
ozivil a proved] ovéteni funkEnosti vSech periferii. Pfipravek je pln€ funkéni. Zkousky,
které jsem pfi praci na projektu provedl, potvrdily, ze programator USB Blaster funguje
spravné. Podarilo se rovnéz vyfeSit problém s programatorem Presto, které uvadi
vyrobce programatoru. Zejména omezeni frekvence programovani a uprava SVF
souboru. Zpracoval jsem n€kolik VHDL konstrukci pro ovéfeni funkce piipravku. Tyto
konstrukce byly vytvoreny na zakladé Sablon, které jsem vytvofil. Oba typy Sablon i
vSechny priklady jsou uvedeny na doprovodném CD. DalSim tkolem bylo vytvofit
manual pro praci s pfipravkem a postupy praci v navrhovém systému QUARTUS II
vcetné doprovodnych aplikaci pro simulace a analyzu, jelikoz Altera na svém webu
nema pfiliS§ mnoho informaci o praci s navrhovym systémem QUARTUS II. V tomto
ptipadé€ ma spolecnost Xilinx mnohem lépe feSenou uzivatelskou podporu. Tento navod
by mél poslouzit pro praktickou praci s pfipravkem pro nové uzivatele se systémem
QUARTUS IL

31



LITERATURA

[1]

POUPA, M. Programovatelné Logické Obvody |online]. Dostupné na www:
www.fel.zcu.cz.

CPLD a FPGA 1.dil - ©popis obvodi [online]. Dostupné na www:
http://pandatron.cz/?481&cpld_a fpga 1.dil - predstaveni obvodu.

MAX II Device Family Data Sheet [online]|. Dostupné na www: www.altera.com.
Programatory ASIX — referenéni prirucka [online]. Dostupné na www: www.asix.cz.
74HC14 Data Sheet [online]. Dostupné na www: www.gme.cz.

Quartus IT Handbook v11.0 Vol.2[online]. Dostupné na www: www.altera.com

Quartus II Handbook v11.0 Vol.3[online]. Dostupné na www: www.altera.com

32


http://www.fel.zcu.cz
http://pandatron.cz/748
http://www.altera.com
http://www.asix.cz
http://www.gme.cz
http://www.altera.com
http://www.altera.com

SEZNAM SYMBOLU, VELICIN A ZKRATEK

PLD
SPLD
CPLD
FPGA
JTAG
TDO
TDI
TMS
TCK
VHDL
EEPROM
PLA
PAL
GAL
LED

Programmable Logic Device

Simple Programmable Logic Device
Complex Programmable Logic Device
Field Programmable Gate Array
Join Test Action Group

Test Data Output

Test Data Input

Test Mode Select

Test Clock

Hardware Description Language
Electrically Erasable Programmable Read Only Memory
Programmable Logic Array
Programmable Array Logic

Generic Array Logic

Light Emited Diode

Serial Vector Format

Not And

Exclusive Or

Digital to Analog Converter
Random Access Memory

User Flash Memory

In Systém Programming

Quartus Project File

Block Diagram File

User Constrainsts File

Standard Delay format Output file
VHDL Output file

VHDL Test file

Synopsys Design Constraint file
Quartus Settings File
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B ZDROJOVE KODY

B.1  Déli¢ kmito¢tu — zdrojovy kod

LIBRARY ieee;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;
USE ieee.std logic 1164.all;

ENTITY delicka kmitoctu IS

PORT

(

clk50: IN STD LOGIC;
mhertz: OUT STD_ LOGIC;
khertz: OUT STD_ LOGIC;
hertz: OUT STD_ LOGIC

) ;
END delicka kmitoctu;

ARCHITECTURE delicka kmitoctu architecture OF delicka kmitoctu IS

SIGNAL mhertz_count: STD_LOGEC_VECTOR(S DOWNTO 0O) := (OTHERS => '0'");
SIGNAL khertz_count: STD_LOGIC_VECTOR(9 DOWNTO O0) = (OTHERS => '0"');
SIGNAL hertz_count: STD_LOGIC_VECTOR(9 DOWNTO 0O) := (OTHERS => '0'");
SIGNAL mhertz en: STD LOGIC := '0';
SIGNAL khertz en: STD LOGIC := '0';
SIGNAL hertz en: STD LOGIC := '0';
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1l' THEN
mhertz count <= mhertz count + 1;
IF mhertz count = "110001" THEN -— 49
mhertz en <= '1"';
mhertz count <= (OTHERS => '0');
ELSE
mhertz en <= '0';
END IF;

END TIF;
END PROCESS;

mhertz<=mhertz en;


http://ieee.stdlogicll64.all

-— generace 1 kHz z mhertz en
PROCESS (clk50) BEGIN

IF clk50'event AND clk50 = '1l' THEN
IF mhertz en = '1l' THEN
khertz count <= khertz count + 1;
IF khertz count = "1111100111" THEN -— 999

khertz en <= '1";
khertz count <= (OTHERS => '0');

ELSE
khertz en <= '0';
END IF;
ELSE
khertz en <= '0';
END IF;
END IF;

END PROCESS;
khertz<=khertz en;

—-— generace 1 Hz z 1 kHz
PROCESS (clk50) BEGIN

IF clk50'event AND clk50 = '1l' THEN
IF khertz en = 'l' THEN
hertz count <= hertz count + 1;
IF hertz count = "1111100111" THEN -— 999

hertz en <= '1";
hertz count <= (OTHERS => '0');

ELSE
hertz en <= '0';
END IF;
ELSE
hertz en <= '0';
END IF;
END IF;

END PROCESS;
hertz<=hertz en;

END delicka kmitoctu architecture;



B.2 Radit displeje — zdrojovy kéd

library

IEEE;

use IEEE.STD LOGIC 1164.ALL;
use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY disp IS
PORT (clkb50: IN STD LOGIC;
khertz: IN STD LOGIC;
digit: OUT STD_ LOGIC VECTOR(5 DOWNTO O) ;
seg: OUT STD_LOGIC VECTOR(7 DOWNTO O0) ;
Ac: IN STD LOGIC VECTOR (5 downto O0);
B: IN STD LOGIC VECTOR (5 downto O0);
C: IN STD LOGIC VECTOR (5 downto O0);
D: IN STD LOGIC VECTOR (5 downto O0);
E: IN STD LOGIC VECTOR (5 downto O0);
E: IN STD LOGIC VECTOR (5 downto O0);
dp: IN STD LOGIC VECTOR (5 downto O0)
)i
END disp;
ARCHITECTURE Behavioral OF disp IS
SIGNAL cd: STD LOGIC VECTOR(2 DOWNTO 0) := "000";
SIGNAL curr: STD LOGIC VECTOR(5 DOWNTO 0) := "000000";
SIGNAL dot: STD LOGIC := '0';
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = 'l' THEN
——inkrementace "ukazatele" - vyber vzdy jen jedne ze sesti segmentovek
IF khertz = 'l' THEN
cd <= cd + 1;
IF cd = "101" THEN
cd <= "000";
END TF;
END TF;

—-— podle "ukazatele" cd je aktivovana prislusna pozice (aktivni v 0)

CASE cd IS --
WHEN "00O0"
WHEN "0O01"
WHEN "010"
WHEN "O011"
WHEN "100"
WHEN OTHERS
END CASE ;

curr
curr
curr
curr
curr
curr

<=
<=
<=
<=
<=
<=

E;
14
;
14

’

> w QUM

’

—- nastaveni prislusneho znaku

CASE
WHEN
WHEN
WHEN
WHEN
WHEN

curr IS

"ooooo00" =

"000001™
"000010™
"000011™
"000100™

seg
seg
seg
seg
seg

<=
<=
<=
<=
<=

dot
dot
dot
dot
dot

curr je zobrazena cifra, digit je pozice na displeji

digit <= "111110"; dot <= dp(0);
digit <= "111101"; dot <= dp(1l);
digit <= "111011"; dot <= dp(2);
digit <= "110111"; dot <= dp(3);
digit <= "101111"; dot <= dp(4);
digit <= "011111"; dot <= dp(5);

na segmentovce podle BCD kodu na vstupu

& "Olllllil“; -—- 0
& "0000110"; -— 1
& "1011011"; -— 2
& "1001111"; -—- 3
& "1100110"; -— 4



WHEN "000101" =
WHEN "000110"
WHEN "000111"
WHEN "001000"
WHEN "001001"
WHEN "001010"
WHEN "001011"
WHEN "001100"
WHEN "001101"
WHEN "001110" =
WHEN

END CASE;

END IF;

seg
seg
seg
seg
seg
seg
seg
seg
seg
seg

= dot

dot
dot
dot
dot
dot
dot
dot

= dot
= dot

OTHERS => seg <= dot &

END PROCESS;

END Behavioral;

"1101101";
"1111101";
"0000111";
"1111111";
"1101111";
"1110111";
"1111100";
"0l11001";
"1011110";
"1111001";
"1110001";
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B.3 Hodiny — zdrojovy kod

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY cas IS

PORT (c1lk50: IN STD LOGIC;
hertz: IN STD LOGIC;
SW: IN STD LOGIC VECTOR (0 to 11);
tll: IN STD LOGIC;
A: OUT STD_ LOGIC VECTOR (5 downto 0);
B OUT STD_ LOGIC VECTOR (5 downto 0);
C: OUT STD_ LOGIC VECTOR (5 downto 0);
D: OUT STD_ LOGIC VECTOR (5 downto 0);
E: OUT STD_ LOGIC VECTOR (5 downto 0);
F OUT STD_ LOGIC VECTOR (5 downto 0)
) ;
END cas;
ARCHITECTURE Behavioral OF cas IS
SIGNAL diods: STD LOGIC VECTOR (11 downto 0):="000000000000";
SIGNAL hodiny: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL minuty: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL sekundy: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL hod: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL min: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL sec: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL Al: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL Bl: STD LOGIC VECTOR (5 downto 0) :="000000";
SIGNAL Cl: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL D1: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL El: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL F1: STD LOGIC VECTOR (5 downto 0):="000000";
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1l' THEN

IF tll='1" then
hodiny <= NOT sw(0 to 5);
hod <= NOT sw(0 to 5);
Cl <= "000000";
minuty <= NOT sw(6 to 11);
El <= "000000";
min <= NOT sw(6 to 11);
sekundy <= (OTHERS => '0');
END IF;

IF hertz='l' THEN
sekundy <= sekundy + 1;
sec <= sekundy;
Al <= "000000";
min <= minuty;
hod <= hodiny;

40



Cl <= "000000";

E1l <= "000000";

IF sekundy = "111011" THEN
sekundy <= "000000";
minuty <= minuty + 1;

IF minuty = "111011" THEN
minuty <= "000000";
hodiny <= hodiny + 1;

IF hodiny = "010111" THEN
hodiny <= "000000";
END IF;
END IF;
END IF;
END TF;

IF sec < "001010"™ then
Bl <= sec;

ELSIF sec >= "001010" then
Al <= Al + "000001";
sec <= sec - "001010";

END IF;

IF min < "001010" then
D1 <= min;

ELSIF min >= "001010" then
Cl <= C1 + "000001";
min <= min - "001010";

END IF;

IF hod < "001010" then
Fl <= hod;

ELSIF hod >= "001010" then
El <= E1 + "000001";
hod <= hod - "001010";

END IF;

END IF;
END PROCESS;

A<=Al; B<=Bl; C<=Cl; D<=Dl; E<=El; F<=F1;

END Behavioral;
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B.4 Bitové operace — zdrojovy kod

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY operator IS

PORT (
A in std logic vector (3 downto 0);
B : in std logic vector (3 downto 0);
tll: in std logic;
tl2: in std logic;
tl3: in std logic;
tl4d: in std logic;
tl5: in std logic;
C out: out std logic vector(3 downto 0);
A out: out std logic vector(3 downto 0);
B out: out std logic vector(3 downto 0);
khertz: in std logic

)i
END operator;

ARCHITECTURE Behavioral OF operator IS

SIGNAL C: std logic vector (3 downto 0):="0000";

SIGNAL A in: std logic vector (3 downto 0):="0000";

SIGNAL B in: std logic vector (3 downto 0):="0000";
BEGIN

PROCESS (khertz, tll, tl2, tl13, tl4, tl5) begin

IF khertz'event AND khertz = 'l' THEN
A in <= not A;
B in <= not B;

IF tll='1" then
C <= A in and B _in;
ELSIF tl12='1l' then
C <= A in or B in;
ELSIF t13='1l' then
C <= A in xor B in;
ELSIF tl4='1l' then
C <= A in nor B in;
ELSIF t15='1l'"' then
C <= not A in;
END IF;
END IF;
END PROCESS;

C _out <= not C;
A out <= not A in;

B out <= not B _in;

END Behavioral

42



B.5 Prevod BIN to HEX — zdrojovy kod

library IEEE

’

use IEEE.STD LOGIC 1164.ALL;
use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY disp
PORT (c1k50
SW:
digit
seqg:
diod:
tll,
) ;

IS

14

tl2,

kH,

END disp;

khertz: IN STD LOGIC;

tl3,

IN STD LOGIC VECTOR

OUT STD_ LOGIC VECTOR
OUT STD_ LOGIC VECTOR
OUT STD_ LOGIC VECTOR

tl4, tl5: IN STD LOGIC

ARCHITECTURE Behavioral OF disp IS

SIGNAL cd:
SIGNAL cur
SIGNAL dp:

r:

SIGNAL bcdint:

SIGNAL swl

SIGNAL tlacitko:

STD LOGIC VECTOR(2 DOWNTO O0)
STD LOGIC VECTOR(3 DOWNTO O0)
STD LOGIC := '0';

STD LOGIC VECTOR(23 downto 0);
STD LOGIC VECTOR(11l downto O0):
STD LOGIC VECTOR (4 downto O0):

BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1l' THEN

bcdint <= sw & swl;

IF khertz en = 'l' THEN
cd <= cd + 1;
IF cd = "101" THEN

cd <= "000";

END IF;

END IF;

—— podle "ukazatele" cd je aktivovana prislusna pozice

CASE cd IS

WHEN "000" =
WHEN "001" =
WHEN "010" =
WHEN "O011" =
WHEN "100" =

—— curr je zobrazena cifra,

curr
curr
curr
curr
curr

<=
<=
<=
<=
<=

bcdint

bcdint

11 DOWNTO O) ;
5 DOWNTO O0) ;
7 DOWNTO O0) ;
11 DOWNTO O) ;

"OOO";
"OOOO";

"111111111111";
"00000";

(aktivni v 0)
digit je pozice na displeji

bcdint (3 DOWNTO 0); digit <="111110"; dp <='0"';

bcdint
bcdint

7 DOWNTO 4); digit <="111101"; dp <='0"';

11 DOWNTO 8); digit <="111011"; dp <='0';
15 DOWNTO 12); digit<="110111"; dp <='0';
19 DOWNTO 16); digit<="101111"; dp <='0"';

WHEN OTHERS => curr <= bcdint (23 DOWNTO 20);digit<="011111"; dp <='0";

END CASE ;

—— nastaveni prislusneho

CASE curr IS

WHEN "1111" =
WHEN "1110"
WHEN "1101"
WHEN "1100"
WHEN "1011"
WHEN "1010"
WHEN "1001"
WHEN "1000"
WHEN "O0111"

seg
seg
seg
seg
seg
seg
seg
seg
seg

& "Olllllil“; -—- 0
dp & "0000110"; -— 1
dp & "1011011"; -— 2
dp & "1001111"; -—- 3
dp & "1100110"; -— 4
dp & "1101101"; -- 5
dp & "1111101"; -- 6
dp & "0000111"; -— 7
dp & "1111111"; --— 8

znaku na segmentovce podle BCD kodu na vstupu



WHEN "0110" =>
WHEN "0101" =>
WHEN "0100" =>
WHEN "0011" =>
WHEN "0010" =>

WHEN "0001" =>
WHEN OTHERS =>
END CASE;

END IF;

END PROCESS;

END Behavioral;

seg
seg
seg
seg
seg
seg
seg

_dp

dp
dp
dp

dp
dp

22 R R R

"1101111";
"1110111";
"1111100";
"0111001";
"1011110";
"1111001";
"1110001";
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B.6 Citat — zdrojovy kod

LIBRARY ieee;
USE ieee.std logic 1164.ALL;
USE ieee.std logic unsigned.ALL;

Entity Counter IS
PORT (hertz, Smer, Areset, Sreset, Nacteni, CEn:IN std logic;

Din: IN std logic vector (3 downto O0);
Count: OUT std logic vector (3 downto O0)

) ;
END Counter;
ARCHITECTURE CountArch OF Counter IS
SIGNAL CntInt: std logic vector (3 downto 0):= "1010";

BEGIN

PROCESS (hertz, Areset) BEGIN

IF Areset = 'l1' THEN
CntInt <= "0000";
ELSIF (hertz'event AND hertz = '1l') THEN
IF Sreset = '1l' THEN
CntInt <= "0000";
ELSIF Nacteni = '1l' THEN
CntInt <= not Din;
ELSIF CEn = '1l' THEN
IF Smer = '1' THEN
CntInt <= CntInt + 1;
ELSE
CntInt <= CntInt - 1;
END IF;
END IF;
END IF;

END PROCESS;

Count <= not CntInt;

END CountArch;
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